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1. Vigtigt

Denne elektroniske brugervejledning er beregnet
til alle, der bruger Philips-skaermen.Tag den tid du
behgver for at laese vejledningen, inden du bruger
skeermen. Den indeholder vigtige oplysninger om

bemazrkninger angaende brugen af din skaerm.

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

) Advarsler

Anvendelse af kontrolelementer, justeringer eller
fremgangsmader, der ikke er beskrevet i denne
dokumentation, kan resultere i elektrisk stad,
elektriske ulykker og/eller mekaniske ulykker:
Lees og felg disse vejledninger, nar du tilslutter og
anvender din computerskarm:

Betjening:

*  Skaermen skal holdes veek fra direkte sollys,
savel som meget kraftigt lys og andre
varmekilder. Leengere udsattelse for disse
typer omgivelser kan medfgre affarvning og
beskadige skaermen.

* Fjern alt, der kan risikere at falde i
ventilationshullerne eller forhindre korrekt
afkeling af skeermens elektronik.

* Bloker ikke ventilationshullerne pa kabinettet.

* Ved placering af skaermen skal du sikre dig,
at det er let at komme til stremstikket og
stikkontakten.

*  Hvis der slukkes for skeermen ved at fierne
stremkablet eller jeevnstremsledningen, skal du
vente 6 sekunder, fer du satter stremkablet
eller jevnstramsledningen til igen for at opna
normal betjening.

Brug altid et godkendt strgamkabel, der

er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

Udseet ikke skeermen for kraftige vibrationer
eller sted under anvendelse.

SI& ikke pa skeermen, og tab den ikke under
brug eller transport.

Vedligeholdelse:

Som en beskyttelse af skeermen skal du undga
at trykke kraftigt pa skeermpanelet. Nar du
flytter din skeerm, sa tag fat om rammen for at
lzfte den; laft ikke skeermen ved at sztte din
hand eller fingre pa skeermpanelet.
Tag stikket ud fra skaermen, hvis du ikke skal
bruge den i en leengere periode.
Tag stikket ud at kontakten til skeermen, hvis
du skal renggre den med en let fugtet klud.
Skeermen kan terres af med en ter kiud,
nar der er slukket for strgmmen. Under alle
omsteendigheder, ma der ikke bruges organiske
oplasningsmidler til renggring af din skaerm.
For at undga risiko for elektrisk sted eller
permant beskadigelse af anleegget, sa ma du
ikke udseette skaermen for stev, regn, vand eller
miliger med hej fugtighed.
Huvis din skaam bliver vad, skal den tgrres af
med en ter klud sa hurtigt som muligt.
Hvis der kommer fremmed substans eller vand
ind i skeermen, sa sluk straks for stremmen og
tag stikker ud. Fjern derefter den fremmede
substans eller vandet, og send skaermen til
servicecenteret.
Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.
For at opretholde den bedste ydelse af din
skaerm og for langvarig brug, sa brug skeermen
et sted, der er indenfor fglgende temperatur-
og fugtighedsomrade.

o Temperatur: 0-40°C 32-95°F

o Fugtighed: 20-80% RH



*  VIGTIGT: Segrg altid for at aktivere en
pauseskeerm, der bevaeger sig, nar skaermen
efterlades uden at blive anvendt. Du skal altid
bruge en pauseskaerm eller et andet program,
der opdaterer skaermen regelmassigt, hvis
du viser statisk materiale i leengere perioder.
Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage, at det
“braendes fast” pa skeermen, dvs. de sakaldte
“"spogelsesbilleder” pa din skaerm.

* Fastbreending” og "spagelsesbilleder”
er velkendte faenomener inden for
skeermpanel-teknologien. “Fastbreending” og
““spagelsesbilleder” forsvinder oftest gradvist
efter en vis periode, efter skaermen er slukket.

) Advarsel

Imidlertid forsvinder alvorligere tilfeelde af
“fastbreending” og “‘spagelsesbilleder” ikke og kan
ej heller fiernes ved reparation. Ovennzvnte
skader er ikke daekket af garantien.

Service
* Kabinettet ma kun &bnes af kvalificeret
servicepersonale.

* Hvis der er behov for et dokument til
reparation eller integration, s kontakt
dit lokale servicecenter. (Se kapitel om
"Kundeinformationscenter")

»  For oplysninger om transport, se "Tekniske
specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

& Bemzrkning

Kontakt en servicetekniker, hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pd, hvad
du skal gere, ndr betjeningsinstruktionerne, der er
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forsigtighedsregler og advarsler

| hele denne vejledning kan tekstblokke vaere
ledsaget af et ikon og std med fed eller kursiv
skrift. Disse blokke indeholder bemarkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

© Bemarkning

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

@ Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab af
data.

) Advarsel

Dette ikon angiver risiko for personskader og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater og
er eventuelt ikke ledsaget af et ikon. | sddanne
tilfelde er den givne udformning af advarslen
lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of,

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please

visit wwwi.philips.com/about/sustainability/recycling.



2.  Hold pa skaermens stander med begge

2. Ops&tning af skeerm heaender, og se&t med en fast hand standeren
ind i fodsgjlen.

2.1 Installation (1) Paszt forsigtigt fodstykket p fodsajlen,
saledes at lasen fastlaser fodstykket.

(2) Spaend skruen, der sidder nederst pa
fodstykket med fingrene, sa fodstykket
sidder godt fast pa fodsgjlen.

El Emballagens indhold

VGA (optional) DVI (optional)

E1 Installation af stander

1. Anbring skaermen med forsiden vendt nedad
pa en blad og jeevn overflade, og var forsigtig
med ikke at ridse eller beskadige skeermen.




El Tilslutning til PC

g Y i

2.2 Brug af skaerm

PHILIPS

[} o e
e
o: S1E]

@ AC stromindgang

© VGA-indgang

O DVI-D input

@ Kensington anti-tyverisikring

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skaermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pd computeren.

Seet computerens og skaermens
netledninger til et stik i naerheden.

Taend for computeren og skarmen. Hvis
skaermen viser et billede, er installationen
gennemfart.

PHILPS
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0 S/0K menuen.
Ga tilbage til det forrige OSD-
© < niveau.
o ) |Skift display-format.
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) |Skift display-format.
Smartlmage Lite. Der kan veelges
@ D |mellem tre funktioner: Standard,
Internet og Game (Spil).




F1 Beskrivelse af OSD-skarmen OSD-menuen

Hvad er OSD (On-Screen Display)? Nedenstaende er en generel oversigt over

strukturen i OSD-displayet. Du kan anvende den
Visning pé skeermen [On-Screen Display som opslag, ndr du senere skal orientere dig i de
(OSD)] er en funktion pé alle Philips skaeerme. forskellige justeringer.

Den satter en slutbruger i stand til at justere
skaermindstillingerne, eller vaelge skaermens
funktioner direkte via et instruktionsvindue pa . C VGA
skaermen. Et brugervenligt skaermvisningsinterface
vises som nedenfor:

Main menu Sub menu

DVI (available for selective models)

Picture Format — Wide Screen, 4:3
— Picture
1 97E3 L Brightness — 0~100
Contrast — 0~100
SmartContrast — On, Off
Color Temperature — 6500K, 9300K
|— Color
sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English . Espaiiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckuii, AL, Tirkge

[— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
[~ Transparency — Off,1,2,3,4
L— OSD Time out — 55,105,205,305,60s
de en
100
TN s — Auto
LR so
1 — H. Position — 0~100
[~ V. Position — 0~100
Language L Phase — 0~100
0SD Settings | Closk o
— Resolution Notification — On, Off
Setup . — Reset — Yes,No
L Information

Grundlzggende og enkle anvisninger til
kontrolknapperne

Pa OSD-skaermen, der er vist ovenfor, kan brugere
bruge w a-knapperne pa skaermens frontkant til at
bevage cursoren med, OK for at bekrafte et valg
eller en zendring.



El Meddelelse om oplesning 2.3 Fjern standeren og foden

Denne skaerm er designet til optimal ydelse ved El Fjernelse af foden

dens naturlige oplasning: 1366768 ved 60Hz. Nar  Inden du begynder at adskille skeermens stander,
skeermen bruger en anden oplasning, ses falgende  skal du falge vejledningerne nedenfor for at undgd
advarsel pa skeermen: Brug 1366x768 ved 60Hz ~ beskadigelse og personskade.

for at opna det bedste resultat.

Advarslen vedrgrende den naturlige opl@sning
kan deaktiveres under Setup (Installation) i OSD
(skeermmenuen).

1. Anbring skeermen med forsiden vendt nedad pa
en jeevn overflade, og veer forsigtig med ikke at
ridse eller beskadige skaermen.

B Fysisk funktion

Vip

2. Aftag fodstykket fra fodsgjlen ved at:

(1) Lasne skruen, der sidder nederst pa
fodstykket, med fingrene.

(2) Skub forsigtigt op og ned for at udlgse
lasen, der laser fodstykket, og treek
fodstykket af fodsgjlen.




E1 Fjernelse af foden

1. Du kan bruge en fladhovedet skrutreekker,
du stikker ind i de to udlgsningshuller pa
haengslets daeksel og forsigtigt lirke haengslets
deeksel for at fierne det.

2. Fjern de 4 skruer og fjern derefter foden fra
skeermen.




3. Billedoptimering

Bl Hvordan aktiveres Smartlmage Lite?

3.1 Smartimage Lite

El Hvad er dette?

Smartlmage Lite er forudindstillede indstillinger,
der optimerer skaermen i henhold til indholdet, og
som indstiller den dynamiske lysstyrke, kontrast,
farve og skarphed i realtid. Uanset om du arbejder
med tekstprogrammer; ser billeder eller ser video,
sa giver Philips Smartlmage Lite den optimale
skeermydelse.

E1 Hvorfor behgver jeg det?

Du gnsker en skaerm, som giver det bedste
billede for alle typer indhold. For at @ge skaerm-
oplevelsen, indstiller Smartlmage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed i
realtid.

E Hvordan virker det?

Smartimage Lite er en eksklusiv, farende Philips-
teknologi, som analyserer indholdet pa skeermen.
Ud fra det valgte scenarie forbedrer Smartlmage
Lite dynamiske billeders og videoers kontrast,
farvemathed og skarphed for at forbedre det
viste billede - alt i realtid og blot med et tryk pa
en knap.

1. Tryk p& E] for at starte Smartimage Lite pa
skeermen;

2. Tryk gentagende gange pa @) for at skifte
mellem Standard, Internet og Game (Spil)

3. Smartlmage Lite ses pa skeermen i fem
sekunder, men du kan ogsa trykke pa "OK" for
at bekreefte det.

4. Nar Smartlmage Lite er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge sRGB
skal du deaktivere Smartlmage Lite med ED
foran pa skermen.

Udover at bruge @ til at rulle ned med, kan du
ogsa trykke pa w a for at vaelge og derefter trykke
pa "OK" for at bekrafte valget og derefter igen
lukke Smartlmage Lite OSD.



Der kan veelges mellem tre funktioner: Standard,
Internet, Game (Spil).

@ SmartImage U

Standard

Internet

Standard: Forbedrer teksten og deemper
lysstyrken for; at @ge leesbarheden og nedsztte
anstrengelsen af gjnene. Denne funktion

@ger lesbarheden og produktiviteten, nar der
arbejdes med regneark, PDF filer; skannede
artikler og andre generelle kontorprogrammer.
Internet: Denne funktion kombinerer
farvemaethed og dynamisk kontrast og
skarphed for at vise billeder og lignende
overordentlig klart og i levende farver - alt
uden synlige fejl i det skannet billede og
blegnede farver.

Game (Spil): Aktivér overdrive-kredslgbet for
at fd den bedste reaktionstid, reducere skaeve
kanter for genstande, der beveaeger sig hurtigt
pa skaermen, forbedre kontrastforholdet
mellem lyse og merke omrider. Denne
funktion giver brugeren den bedste
spilleoplevelse.

10

3.2 Smart-kontrast

El Hvad er dette?

Unik teknologi, der dynamisk analyserer det viste
indhold og automatisk optimerer en skaerms
kontrastforhold til maksimal visuel klarhed.

Den gger baggrundsbelysningen og giver et
klarere, friskere og lysere billede eller deemper
baggrundsbelysningen med henblik pa en tydelig
visning af billeder pa merk baggrund.

El Hvorfor behgver jeg det?

Du gnsker den allerbedste visuelle klarhed

og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og lyse spil-
og videobilleder; samt viser en tydelig, laesbar tekst
ved kontorarbejde.Ved at nedsatte skaeermens
stremforbrug, sparer du energiomkostninger og
forleenger skaermens levetid.

E Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres det
viste indhold i realtid, og farver og baggrundslysets
intensitet indstilles. Denne funktion forbedrer den
dynamiske kontrast og giver sdledes en bedre
underholdningsoplevelse, nar du ser videoer eller
spiller spil.



3.3 Philips SmartControl Lite Opstartsguide
* Efter installation af SmartControl Lite starter

Det nye SmartControl Lite-software fra Phillips guiden automatisk, ndr du dbner programmet
giver dig mulighed for at kontrollere skaermen via forste gang.

et nemt, grafisk interface. Komplicerede justeringer *  Guiden leder dig trin for trin gennem

herer fortiden til. Dette brugervenlige software indstillingen af skaermen.

guider dig gennem finindstilling af oplasning, * Dukan ogsa ga til Plug-in menuen, for at starte
kalibrering af farve, justering af clockning/fase, guiden pa et senere tidspunkt.

RGB-hvidpunkt osv. * | Standard-vinduet kan du indstille flere

funktioner uden brug af guiden.
Dette igjefaldende, ikon-baseret software er

udstyret med den seneste teknologi i algoritmer B e
for hurtig behandling og reaktion, og er tilmed SmartControl Lite PHILIPS
Windows 7 kompatibel, og klar til at forbedre din Wizard

oplevelse med Philips-skeermel!

El Installation u

Adiust Audo

* Felg instruktionen og fuldfer installationen.

¢ Du kan starte, nar installationen er fuldfert.

*  Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
varktgjslinjen.

i

Color Input

y ° )
; w i

=
Hep
Start Wizard
PHILIPS o philips.comiwelcome
Monitor driver and software installation

Syem recur

Philps SmareControl

Sysom sppor

1. Sytam support Windows 7. Viss, X.

3 Pips Monior g and Py support.

11



1 Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):

* Med Adjust Menu (Indstillingsmenuen) kan
du indstille Brightness (Lysstyrken), Contrast
(Kontrast), Focus (Fokus), Position (Position)
og Resolution (Oplasning).

*  Udfer indstillingen ved at felge instruktionerne.

* Installationen kan annulleres med Cancel
(Annuller).

8 SmartControl 2- Philps 22581 (€S30715000001) (2)\X)

SmartControl Lite PHILIPS

Brightness

Improperly adjusted Brightness wil esut n 2 loss of
detal n darker image areas. Adjust the Brightness for
the best possble picture quaity
Lower the Brightness to the minimum level.
Raise the Brightness to the desred level.
Adjust the Brightness as needed to achieve
an equal separation of the strpes.

ad

Contrast
Color
A
pe-. Foaus Brightness 100
+ : :
Poston
Undo Reset
Options %
!! Resolution
Help
B SmartControl 2.- Philps 22581 (€S30715000001) ()X

SmartControl Lite PHILIPS

Contrast
Adjust the Contrast (use the sider) to keep detais in
ighter image areas.

1. Rasethe Contrast unt the rumbers 1 and 2
longe vsb.
wer th

ontrast to make the

]

S
==
Adijust
2
\g Contrast.
Color
=
: . .
_ - :
$ - .
X
Options Undo Reset.
L

%

Help

12

8 smartContol

SmartControl Lite

Adjust ).
Brightness
Contrast

Color %N ~

- Focus.
AN

Postion

Options ”
Resolution

Help

8 smartControl

SmartControl Lite

Adjust
Brghtness
\g Contrast
Color ~a
A
3 Foaus
5
g %
Options o
i! Resolution
Help
8 smartcontrol

SmartControl Lite

]

Adiust

Brghtness

\g Contrast
Color ac
el
Focus

i

Options

®

Help

2.- Philps 22581 (€530715000001) 3] X
PHILIPS

Focus

\’nurmsmav‘s('mng needs to be synchronized with
the video

1 Chunse Auto Setup.

2. Ifthe vertical baMs are stil visble, you'l need

to adjust the Pi

Pitch: Try to make the vertical bands dsappear.
Phase: Adjust to the brightest setting to minimize
movement on the screen.

pich

g

Phase

_ Undo _ AutoSetwp

2 - Philips 22581 (C530715000001) (%)X
PHILIPS

Position

Use the Position buttons to center the image o
your dispay. Usng this tool, you Gan posicon the image
up, down, left, or i

1. Use the Up/Down buttons to center the image
vertical

2. Use the Left/Right buttons to center the image
horzontaly,
Undo Reset

2 Philps 22581 (C530715000001) {#}\X)
PHILIPS

Resolution

You are currently at  Preferred resolution. For your
 to show crisp, clear text, colors, and images,

your dispiay shouid be set to s Preferred resolution.

I your diplay i at 2 Non-Preferred resolution, cick

on the Preferred button to change your resolution to

I Enable Resokution Notfer

Picture Format.
I™ 413 aspect ratio




Color menu (Farvemenu):

Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau), White
Point (Hvidpunkt), udfer kalibrering og
Smartimage Lite (se afsnittet Smartlmage Lite).
Udfer indstillingen ved at falge instruktionerne.
Se nedenstaende oversigt med
undermenupunkter baseret pa din indtastning.
Eksempel pa Color Calibration
(farvekalibrering)
8 SmartControl 2 - Phiips 22581 (CS30715000001) {Z}\X)
SmartControl Lite PHILIPS
Black Level
Improperly adjusted Black Level wil result in a loss of
Adjust lRlG!B
/ Red 50
Biack Level = +
‘Color White Point - &
\Q Oepl Garra = 4
w -
Help
B SmartControl 2~ Philps 22581 (C530715000001) {F]X

SmartControl Lite PHILIPS

White Point

White Point is the paint at which equal combinations
f en, and biue fight at ful intensty create

350 select the Whte Pont value or the best
] possble cobr quaky.

Adiust e

i

Color ‘Whte Point
—_ Whte point 600K
Display Gamma = - &
-l
undo Reset
Options Galbration
&p
Smartimage
He

13

8 SmartControl 2- Philps 22581 (CS30715000001) |2\,

SmartControl Lite PHILIPS
Display Gamma

Garra .2 component of the pelbrghtness 2
kY. A ower Gar value produces bihter el
13 e GareTa ek roduces darket ps. The

defauk value for Gama & 2.2.

| To adjust Gamma, Smartimage must be set to OfF.
i Cick the Smartimage OFf button before adiusting
&

amma,
Adjust RGE

Back Level

1. Use the sider to select the desred Gamma.

White Paint Dispay Garna 22

o+

O )|

Disply Gamma Smartimage OFF
L
Optons colbrtion inte e
ap
smarinage

®

Help

[ Smanconaon 2 Pnaps 22581 (CS3U/15000001) (LI

SmartControl Lite PHILIPS

Calibration

Your display needs
fort

roperly calibrated i order
range of cobors accurately

rake i s to mage auaky o
Uhenever you moe your dspay o3 new caton.
) 1. Make a other necessary adustments to mage
[l quaky frst

Adiust RGB 2. Press Show Me to leam how to use the
calibration took.

> 3. Finaly, press Start to begin the calibration
ess
sl ' Enable color calibration
Color software desgnad n colsboraton wih Joseph
omee.
Color White Point Protected by U.S. Patent No. 6,686,953
\g Ospy Ganna
Options. Galbraton
ap
Smartimage

Show Me start

Quick View

"Show Me" (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indlaeser for/efter-
billederne.

For at vende tilbage til Color (Farve) vinduet,
skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan du
ikke udfgre en farvekalibrering, ligesom start-
og quick-visning knapperne er gratonede.
Der skal vaere patentoplysninger pa
kalibreringsskaermen.



Forste farvekalibreringsskaerm:

*  Previous (Foregaende) knappen er deaktiveret,
indtil du gar videre til den anden farveskarm.

*  Next (Naste) gar til efterfelgende mal
(seks mal).

*  Final next (Afsluttende Neeste) gar til File >
Presets (File > Forvalg) vinduet.

*  Cancel (Annuller) lukker Ul og vender tilbage

til "plug in" siden.

Smartlmage Lite

Smart-Billede - tillader brugeren at aendre
indstillingerne, for at opna en bedre
skeermindstilling baseret pa indholdet.

Nar der indstilles pa Entertainment
(Underholdning), aktiveres SmartContrast og
SmartResponse.

B smartControl 2%

SmartControl Lite PHILIPS

SmartImage

‘Smartimage provides different brightness and
contrast levels t0 accomodate today's wide range of

s most comfortable or
o lication. Attematively,
smply choose the one that best descrbes s type.

]

Adjust RGE
Back Lavel
Whte Pont

-y
Calibration
@p

Smartimage

G )

Options

~

Game

%

Help
o (1]

Standard
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Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Options (Funktioner)-
rullemenuen. Pa en ikke-understattet skeerm
med DDC/Ci er kun Help (Hjeelp) og Options
(Funktioner) til radighed.
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SmartControl Lite PHILIPS

Preferences

ptions to configure

Priven:es

Adiust Audio

Set Transparency:
@ 0% € 50% C 100%

Select bnguage:
Engish -

Auto Pivot

-
Tnput

i
2

Presets

Muli Monitors

R4

Viser nuvaerende, foretrukne indstillinger.
Funktionen aktiveres ved at afmarke feltet.
Afmarkningsfeltet er en flip-flop.

Enable Context (Aktiver Indhold) menuen er
som standard afmaerket (Til) pa skrivebordet.
Menuen Enable Context (Aktivér kontekst)
viser valgmulighederne i SmartControl Lite
pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen

ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

Enable Task Tray (Aktiver Jobbakke) menuen er
som standard afmaerket (Til) pa skrivebordet.
Menuen Enable Context (Aktiver Indhold)
go, at systembakkens ikon til SmartControl
Lite vises. Et hgjreklik pa jobbakke-ikonen
viser menufunktionerne for Help (Hjelp) og
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



Run at Startup (Ker ved opstart) er

som standard afmarket (Til). Nar den er
deaktiveret, starter SmartControl Lite ikke ved
opstart og ikonet vises ikke i systembakken.
SmartControl Lite kan kun startes fra genvejen
pa skrivebordet eller fra programfilen. Intet
forvalg, som er indstillet til at kere ved opstart,
indleeses nar denne boks ikke er afmaerket (er
deaktiveret).

Enable transparency mode (Aktivér
gennemsigtighedstilstand) (Windows 7,Vista,
XP). Standard er 0% uigennemsigtighed.

"Options > Input" (Funktioner > Indgang) - er
kun aktiv, nar Input (Indgang) er valgt i Options
(Funktioner) rullemenuen. Pa en ikke-understattet
skeerm med DDC/Ci er kun Help (Hjelp) og
Options (Funktioner) til radighed. Alle andre
faneblade i SmartControl Lite er ikke til radighed.

W smartcontrol

SmartControl Lite

2 - Phiips 22581 (C530715000001) {F}(X)

PHILIPS

Tnput

Adjust

Color

Options Presets

S o

Help

Analog In Digital In

Vis Source (Kilde) instruktionsvinduet og
nuvaerende indgangskildeindstillinger.

P3 enkeltindgangsskaerme ses dette vindue
ikke.
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Options > Audio (Funktioner > Lyd) - er

kun aktiv, nar Audio (Lyd) er valgt i Options
(Funktioner) rullemenuen.

Pa en ikke-understettet skeerm med DDC/Ci
er kun Help (Hjaelp) og Options (Funktioner) til
radighed.

8 smartControl 2-Phiips 22581 (C530715000001) (2)\X)

SmartControl Lite PHILIPS

ed loudspeakers by

checking the

Adiust

e
g

Options

N

Presets

o

Muki Monitors

. Volume 100
Help

Undo



Help > User Manual (Hjelp > Brugervejledning)
- er kun aktiv, ndr User Manual (Brugervejledning)
ervalgt i Help (Hjeelp) rullemenuen. Pa en ikke-
understgttet skeerm med DDC/Ci er kun Help
(Hjeelp) og Options (Funktioner) til radighed.

8 SmartControl 2 Phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

User Manual

Adjust

-
(i )
Color ‘n
.
Options x ‘

Version

Helo.

Tech. Support

Options > Version (Funktioner > Version) -
er kun aktiv, nar Version er valgt i Help (Hjelp)
rullemenuen. P& en ikke-understattet skeerm
med DDC/Ci er kun Help (Hjeelp) og Options
(Funktioner) til radighed.

W smartcontrol 2 Philps 22581 (530715000001) (Z)X

SmartControl Lite PHILIPS

Version

Color a
g ocply
.

Options x 'x

!\E Verson

Context Sensitive (Indholdssensitiv) menu
Context Sensitive (Indholdssensitiv) menuen

er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmaerket i
Options > Preferences (Funktioner > Indstillinger)
vinduet, ses menuen.

@ SmartControl
Select Preset 4
wne Display

Context menuen har fire punkter

»  SmartControl Lite - nar valgt, ses About (Om)
skeermen.

*  Select Preset (Veelg Forvalgt) — herefter vises
en hierakisk menu med gemte forvalg, der
straks kan bruges. En afkrydsning viser det
nuvaerende valgte forvalg. Factory Preset
(Fabriksforvalg) kan ogsa hentes i rullemenuen.

* Tune Display (Indstil Skeerm) - abner
kontrolpanelet til SmartControl Lite.

*  Smartlmage Lite - Kontroller nuveerende
indstillinger, Standard, Internet, Game (Spil).



Task Tray (Jobbakke) menu aktiveret

Menuen i systembakken kan ses ved at hgjreklikke
pa SmartControl Lite-ikonet i systembakken. Et
venstreklik starter programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:

* Help (Hjeelp) - adgang til brugervejledningsfilen:

Abner Brugervejledningen med standard
browservinduet.

+  Technical Support (Teknisk Support) - viser
siden med teknisk support.

*  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version,

* About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite

Hvis du vil kere SmartControl Lite igen, skal du
enten veelge SmartControl Lite i programmenuen,
dobbeltklikke pa skrivebordet eller genstarte
systemet.

PHILIPS

SmartControl

‘SmartControl
‘Version 3.20
dhane-standard-R2007-1-04-1151-23
Copyricht 1993-2007 Portrait Displays, Inc.
Patents Pending

Task Tray (Jobbakke) menu deaktiveret

NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun "EXIT" (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil fierne
SmartControl Lite fra systembakken, skal du
deaktivere Run at Startup (Ker ved opstart) i
Options > Preferences (Muligheder > Indstillinger).
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4. Tekniske specifikationer

Billede/Skarm

Skeermpanel-type TFT-LCD
Baggrundslys LED

Panelstgrrelse 47,0 cm (18,5")
Billedforhold 169

Pixel pitch 0,3 x 0,3 mm
Lysstyrke 250 cd/m?
Smart-kontrast 20.000.000:1
Kontrastforhold (typisk) 1000:1
Reaktionstid (typisk) 5ms

Optimal oplgsning 1366x768 @ 60Hz

Synsvinkel 170° (H) / 160° (V)@C/R>10

Billedforbedring Smartimage Lite

Skaermfarver 16,7 M

Vertikal opdateringshastighed 56 -76 Hz

Horisontal frekvens 31 - 83 kHz

sRGB JA

Signalinput DVI-D (digital), VGA (analog)

Inputsignal Separat synk,, synk. pa gren

Brugerfunktioner 197E3L: Ep/v ©/A /<4 2/ O
19783L (IN:@p/v /4 O/« o/ok D

OSD sprog Engelsk, Fransk, Tysk, Italiensk, Russisk, Spansk, Simplificeret

Kinesisk, Portugisisk og Tyrkisk

Andre funktioner

Kensington-las

"Plug & Play" kompatibilitet

Vip

DDC/CI, sRGB, Windows 7, Mac OSX, Linux

-5/+20
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Tendt-tilstand

12,91W (typisk), 13,59W (maks.)

Energiforbrug AC indgangsspaending | AC indgangsspanding | AC indgangsspeending
(EnergyStar 5.0 ved T00VAC +/-5VAC,| ved 115VAC +/-5VAC,| ved 230VAC +/-5VAC,
testmetode) 50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal funktion (typisk) | 10,05W 9,96W 997W

Sovetilstand (Standby) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W

Varmetab* AC indgangsspaending | AC indgangsspanding | AC indgangsspaending
ved 100VAC +/-5VAC,[ 115VAC +/-5VAC, ved 230VAC +/-5VAC,
50Hz +/- 5Hz 50Hz +/- 5Hz 50Hz +/-5Hz

Normal drift 30,304 BTU/t 34,008 BTU/t 34,024 BTUA

Sovetilstand (Standby) 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Fra 1,706 BTU/t 1,706 BTU/t 1,706 BTU/t

Power-indikator

Til-tilstand: Hvid, Standby/Dvale: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

Produkt uden fod

(B xH x D) 462 x 364 x 200 mm
Produkt uden fod

(B xH x D) 462 x 295 x 41 mm
Produkt med fod 2,63 kg

Produkt uden fod 2,194 kg

Produkt med emballage 3,724 kg

i drift)

Temperaturomrade o 1 Ao
(drift) 0°C til 40°C
Temperaturomrade (ikke 90°C il 60°C

Relativ fugtighed 20% til 80%
; Betjening: + 3.658 m

Hgjde -

Ikke drift: + 12192 m
MTBF 30.000 timer
ROHS JA
EPEAT Selv. (www.epeat.net)
Emballage 100 % genbrugelig
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Myndighedernes CE Mark, FCC Class B, GOAST, SEMKO, TCO Certified, UL/cUL,
godkendelser BSMI, 1IS©9241-307, Energy star 5.0
Farve Sort (bagside)/bla (forside)
Finish Skinnende
& Bemzrk

1. EPEAT Guld og Selv er kun gyldig hvor Philips registrer produktet. Besag venligst www.epeat.net for
registreringsstatus i dit land.

Disse data kan @ndres uden varsel. Ga til www.philips.com/support for at hente den seneste version
af brochuren.
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4.1 Oplasning og forudindstillede funktioner
E Maksimal oplasning

P& 197E3L
1366 x 768 ved 60 Hz (analogt input)
1366 x 768 ved 60 Hz (digital indgang)

E1 Anbefalet oplasning

P& 197E3L
1366 x 768 ved 60 Hz (digital indgang)

31,47 720x400 70,09
3147 640x480 59,94
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
47,71 1366x768 59,79

© Bemarkning

Bemaerk, at skeermen fungerer bedst med den
indbyggede oplasning pa 1366 x 768@ ved 60 Hz.
Folg den anbefalede oplasning for at opna den
bedste billedkvalitet.



5. Stremstyring

5.1 Automatisk energibesparelse

Huvis der er installeret et skaermkort eller software
pa pc'en, der er i overensstemmelse med

VESA DPM, kan skaermen automatisk nedsatte
stremforbruget, nar den ikke bruges. Nar input fra
tastatur, mus eller anden input-enhed registreres,
"vagner" skeermen automatisk igen. Nedenstdende
tabel viser denne automatiske energisparefunktions
stremforbrug og signalering:

197E3L

VESA Video | V synk [ L synk Opbrugt strem Diodefarve
tilstand

Aktiv TIL Ja Ja <12.91W (typisk) Hvid

Sovetilstand | FRA | Nej Nej <05W Hvid
(Standby) (blinker)

Kontakt Fra | FRA - - <05W FRA

Folgende opsatning bruges til at male skarmens
stremforbrug.

Indbygget opl@sning: 1366 x 768

Kontrast: 50%

Lysstyrke: 250 nits

Farvetemperatur: 6500k med fuldt, hvidt menster

© Bemark
Disse data kan andres uden varsel.
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6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!
=
cemree - ensures that your display is
designed, manufactured and tested
according to some of the strictest quality and
environmental requirements in the world. This
makes for a high performance product, designed
with the user in focus that also minimizes the
impact on the climate and our natural
environment.

The display you have just purchased
carries the TCO Certified label. This

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality is
tested to ensure top performance and reduce
sight and strain problems. Important parameters
are luminance, contrast, resolution, black level,
gamma curve, colour and luminance uniformity
and colour rendering

* Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

Very low energy consumption both in on- and
standby mode minimize climate impact
Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and heavy
metals such as cadmium, mercury and lead
(RoHS compliance)

Both product and product packaging is prepared
for recycling

The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 57 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

X
z’b

)

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for Environment
Labeling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of
Professional Employees) for TCO versions

Energy Star Declaration
(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR® guidelines
for energy efficiency.

4

ENERGY STAR

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.



Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréguences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, |'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre |'équipement et
le récepteur.

*  Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
* Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This dewvice belongs to catagory B devices as described in EM 55022, unless it is specrli-
cally stated that it is a Class A devics on the specification labal. The following applies to
devicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of tha
devics is obliged to taks all staps necessery to remove sources of intarference to tals-
communication or other devicas.

Pakud neni na typovém &titku poditade uvedeno, Ze spadé do do fidy A podle EN 55022,
spadé automaticky do tidy B podie EN 55022, Pro zafizen zafazend do tfidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-li k rudeni telekomunikatnich nebo
Pnych zafizeni je ufivatel povinmen provést takovd opatfgnl, aby rudeni odstranil.
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Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Pelskiego Centrum Badan i Certyfikacji

Pozostale instrukeje bezpieczensiwa
* Niena Ty s

af Kilka albwisd
ayt przediuz

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)

RHAZHARERZBE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erfiillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildrohre nur eine bauartgleiche
eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

[A]

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.

FEABLEROHS
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter pa
fladskaerme

Philips tilstreeber at levere produkter af den hgjeste
kvalitet.Vi anvender nogle af branchens mest
avancerede produktionsprocesser og udferer en
streng kvalitetskontrol. En gang imellem er defekte
pixler eller sub-pixler paA TFT skaeermpaneler dog
uundgaelige. Ingen producent kan garantere,

at alle paneler vil vaere fri for pixeldefekter,

men Philips garanterer, at enhver skaerm med

et uacceptabelt antal defekter repareres eller
udskiftes under garantien. Dette notat forklarer de
forskellige former for pixeldefekter og definerer
de acceptable defektniveauer for hver type. For
at veere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa

et TFT skeermpanel overskride disse acceptable
niveauer. For eksempel ma hgjst 0,0004% af sub-
pixlerne pa en skeerm veere defekte. Desuden
seetter Philips endnu hgjere kvalitetsnormer for
visse typer eller kombinationer af pixeldefekter,
derer mere generende end andre. Denne
pixelpolitik geelder i hele verden.

subpixel subpixel

v
(il 5

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre
sub-pixler med primerfarverne red, gren og bla.
Ndr mange pixler settes sammen, kan de danne et
billede. Nar alle sub-pixler i en pixel lyser, fremstar
de farvede sub-pixler tilsammen som enkelt hvid
pixel. Hvis de alle er merke, fremstar de tre farvede
sub-pixler tilsammen som en enkelt sort pixel.
Andre kombinationer af oplyste og marke sub-
pixler fremstdr som enkelte pixler i andre farver.

subpixel

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa skeermen
pa forskellige mader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i
hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels eller
underpixels, der altid lyser eller er "pa". Det vil
sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et markt
meanster. Der er felgende typer defekte lyse
prikker:

En teend red, gren eller bld sub-pixel

I @

To sammenliggende tendte sub-pixler:
Rad + Bla = Lilla

Red + Gregn = Gul

Grgn + Bla = Cyan (Lysebla)

Tre sammenliggende teendte pixler (en hvid pixel)
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6 Bemarkning

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end de
omkringliggende prikker:

Defekte mearke prikker

Defekte marke prikker fremkommer som pixels
eller underpixels, der altid er merke eller "fra". Det
vil sige, at en lys prik er en underpixel, der fremstar
pa skermbilledet, nar skeermen viser et merkt
megnster. Der er fglgende typer defekte mearke

prikker:

Tetliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type,
der ligger teet pa hinanden, kan veere mere
igjnefaldende, specificerer Philips ogsa tolerancer
for teetliggende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal et TFT skeermpanel i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,

der overskrider de tolerancer, der er gengivet i
folgende tabeller.

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende taendte sub-pixler 1
3 sammenliggende teendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre
2 sammenliggende mgrke sub-pixler 2 eller ferre
3 sammenliggende marke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller ferre

SAMLEDE DOT-DEFEKTER

Samlede bright- eller black dot-defekter af alle typer

ACCEPTABELT NIVEAU
5 eller faerre

=] Bemarkning

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1509241-307 (ISO9241-307: Testmetoder for ergonomisk
krav, analyse og overensstemmelse for elektroniske skeerme til fremvisning)



7.2 Kundeservice og garanti

Kundeservice og garanti

For oplysninger om garantideekning og geeldende stettekrav i dit omrdde, bedes du besgge www.philips.
com/support. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tIf Pris

Austria Siemens 1&S +43 0810 000206 €007

Belgium E Care +32 078 250851 €0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Germany Siemens &S +49 01803 386 853 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tIf

Belarus NA IBA +37517 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Czech Rep. NA Asupport 800 100 697

Estonia NA FUJITSU +372 6519900

Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Latvia NA “ServiceNet LV" Ltd. +371 7460399

Lithuania NA UAB "Servicenet" +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

S— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)

ﬁ’legiic?ar%egro NA Kim Tec d.o.o. +381 11 20 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31

Turkey NA Techpro +90 212 444 4 832

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter Kundeservice tIf

Argentina Vermont 0800 3330 856

Brazil Vermont 0800-7254101

Kontaktoplysninger tii NORDAMERIKA:

Land Callcenter ASC Kundeservice tlf

Canada Supercom Supercom (800) 479-6696

USA. TOS Teleplan (877) 835-1838

Kontaktoplysninger til Kina:

Kina

Kundeservice tlf: 4008 800 008




Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tlf
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. | . i Tel: (853)-0800-987
: Tel:1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
. . . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
. . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea | NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d}strlbutor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
Jnited Arab 5 AL SHAHD COMPUTER LLC {00971 4 2276525
Emirates
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
ompany =e- +84 5113562666 Can tho Province

33




8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan klares
af brugeren selv. Hvis problemet stadig er der, efter
at du har prevet disse lgsninger, skal du kontakte
Philips's Kundeservice.

El Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at el-ledningen er anbragt i
stikkontakten og bag pa skeermen.

* Kontroller ferst, at stremkontakten foran pa
skeermen er i OFF (FRA) position og tryk den
derefter i ON (TIL) position.

Intet billede (stremdiode blinker hvidt)

* Kontroller; at der er teendt for computeren.

»  Kontroller; at signalkablet er korrekt forbundet
til computeren.

* kontroller; at der ikke er nogen bgjede stikben
i signalkablets tilslutningsende. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan vare aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt forbundet
til computeren. (Se ogsa Hurtig start-
vejledningen).

* Tjek, om skeermkablets stikben er bgjede.

* Kontroller; at der er teendt for computeren.
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AUTO (AUTOM.)-knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.

© Bemarkning
Den automatiske funktion er ikke n@dvendig i DVI
digital-tilstand.

Synlige tegn pa rog eller gnister

*  Forsag ikke at fejlfinde

*  Treek straks skaermens stik ud af stikkontakten

* Kontakt straks en repraesentant fra Philips
kundeafdeling.

Bl Billeddannelses-problemer

Billedet er ikke centreret

* Justér billedets position med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock (Fase/
Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.

Billede vibrerer pa skermen
» Tjek, at signalkablet er korrekt forbundet til

grafikkortet eller pc'en.

Lodret flimren

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.



Vandret flimren

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i USD hovedmenuen. Den kan
kun bruges i VGA-tilstand.

Billedet er slgret, uklart eller for merkt
* Indstil kontrast og lysstyrke i OSD.

Der forbliver et "efterbillede",
"indbraendingsbillede" eller "spagelsesbillede”,
efter at der er slukket for stremmen

»  Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan forarsage,
at det "braendes fast” pa skaermen, dvs. de
sakaldte “spggelsesbilleder’ pa din skaerm.
"Fastbreending” og "'spegelsesbilleder” er
velkendte feenomener inden for skeermpanel-
teknologien. | de fleste tilfeelde forsvinder
"indbreending" eller "efterbillede" eller
"spogelsesbillede” gradvist, efter at stremmen
er slaet fra.

* Serg altid for at aktivere en pauseskarm, der
bevaeger sig, nar skaeermen efterlades uden at
blive anvendt.

*  Serg altid for at aktivere et program, der
opdaterer skaermbilledet regelmaessig, hvis
skarmen viser indhold, der ikke skifter:

* Imidlertid forsvinder alvorligere tilfeelde af
“fastbrending” og “‘spegelsesbilleder” ikke
og kan ej heller fiernes ved reparation.
Ovennavnte skader er ikke deekket af
garantien.

Billedet er forvrenget. Tekst er utydelig eller

sloret

* Indstil pc'ens skeermoplasning som skaermens
anbefalede, native oplgsning.
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Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag. Se
politikken om pixels for yderligere oplysninger.

"Teendt"-lyset er for kraftigt. Det forstyrrer
* Du kan justere "Taendt"-lyset med Stremdiode
i OSD-menuerne.

For yderligere hjalp, se venligst Forbruger-
informationscentre-listen og kontakt Philips’s
Kundeservice.



8.2 FAQ for SmartControl Lite

SP1. Jeg har udskiftet skeermen pé en pc
til en anden skarm, og nu fungerer
SmartControl Lite ikke l&ngere. Hvad skal
jeg gore?

Sv..  Genstart din pc og se, om SmartControl
Lite fungerer nu. Eller skal du afinstallere og
geninstallere SmartControl Lite for at sikre,
at den korrekte driver er installeret.

SP2. SmartControl Lite fungerede fint tidligere,
men nu virker programmet ikke langere.

Hvad skal jeg gore?

Sv.. Hvis nogle af de felgende handlinger har
vaeret udfert, skal skeermdriveren maske
geninstalleres.

* Videografikadapter er blevet udskiftet med
en anden
* Opdater videodriver

Aktiviteter i OS som f.eks. servicepakke

eller programrettelse

» Opdater Windows og opdater skeerm- og/

eller videodriver

* Windows blev startet med skaermens

strom sldet fra eller afbrudt.

For at finde ud af det, skal du klikke

pa "Denne Computer" og derefter pa
Egenskaber -> Hardware ->Enhedsstyrer.
Huvis du ser "Plug & Play skaerm" under
Skeerm, skal du geninstallere. Afinstallér
SmartControl Lite og geninstallér det.

SP3. Efter installation af SmartControl Lite sker
der ingenting, selv om jeg klikker pa fanen
SmartControl Lite og venter, eller der

vises en fejlmeddelelse. Hvorfor?

Sv.. Det skyldes muligvis, at din grafiske adapter
ikke er kompatibel med SmartControl Lite.
Hvis grafikadapteren er en af ovennavnte
meerker; skal du preve at downloade den
mest opdaterede grafikadapterdriver fra
det pageeldende firmas ? websted. Installer
driveren. Afinstallér SmartControl Lite og
geninstallér det igen.

SP4.

Sv.:

SP5.
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Hvis det stadig ikke virker, er vi bange for,
at grafikadapteren ikke understattes. Ga til
Philips websted og kontrollér, om der findes
en nyere driver for SmartControl Lite .

Nér jeg klikker pa "Product Information"
("Produktinformation"), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan vare, at din grafikkortadapterdriver
ikke er den mest opdaterede version, som
fuldt ud understgtter DCC/CI greenseflade.
Prgv at downloade den mest opdaterede
grafikkortadapterdriver fra det pageeldende
firmas ? websted. Installer driveren.
Afinstallér SmartControl Lite og geninstallér
det igen.

Attention

Theft Deterence enabled

Jeg har glemt min PIN-kode til Theft
Deterence (Anti-tyveri) funktionen. Hvad
gor jeg!

Philips servicecenter forbeholder sig retten
til at bede om legitimation og godkendelse
for at kunne etablere skaermens ejer:

Bemaerk, at tyverisikringsfunktionen er en
nyttig funktion, der felger med som gratis
ekstraudstyr. Ansvaret for styring af PIN-
koder ligger alene hos den individuelle
bruger eller organisationen, der opseetter
dem.

Hvis PIN-koden glemmes, kan Philips
servicecenter nulstille den for et mindre
gebyr, efter verificering af ejerskab. Bemaerk,
at denne aktivitet ikke er deekket af standard
garantien.



8.3 Generelle FAQ

SP1:

Sv.:

SP2:

Sv.:

Hvad skal jeg gare, hvis skeermen under
installationen viser "Cannot display this
video mode” (”Kan ikke vise denne
videotilstand’)?

Den anbefalede oplgsning for denne skaerm:

1366x768 @60Hz.

Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte fer

* | Windows Start Menu, veelg Indstillinger/
Kontrolpanel. | Kontrolpanel vinduet veelg
Skeerm-ikonen. | Egenskaber for Skaerm
vinduet veelg "Indstillinger” fanebladet.
Under indstillinger, skub skyderen til
1366x768 pixler.

+ Abn "Avanceret” og indstil
opdateringshastigheden pa 60Hz og klik
derefter pa OK.

* Genstart computeren og gentag trinene
2 og 3 for at bekreefte, at pc'en er indstillet
pa 1366x768 @60Hz.

* Luk for computeren, frakobl den gamle
skaerm og genforbind Philips skeermen.

* Teend for skeermen og derefter for pcen.

Hvad gor den anbefalede
opdateringshastighed for skermen?

Den anbefalede opdateringshastighed for
skaeerme er 60Hz. | tilfeelde af forstyrrelser
pa skarmen skal du sztte den op til 75Hz
og se, om dette flerner forstyrrelserne.

SP3:

Sv.:

SP4.

Sv.:

SP5:

Sv.:

SPé:

Sv.:

Hvad er .inf og .icm filerne pa cd-rom’en?
Hvordan installerer jeg driverne (.inf og
.icm)?

Dette er skaermens driverfiler: Installer
driverne i henhold til brugervejledningens
anvisninger. Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om en
driverdisk, nar du installerer skeermen fgrste
gang. Indsaet (medfelgende cd-rom) i pakken
i henhold til anvisningerne. Skaermdrivere
(inf og .icm filer) installeres automatisk.

Hvordan justerer jeg oplgsningen?

Skaermkortet/grafikdriveren og skaermen
bestemmer sammen oplasningerne til
radighed. Du kan veelge den gnskede
oplesning "Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg "farer vild”, mens jeg
justerer skermen?

Sa skal du blot trykke pa OK og derefter
vaelge "Reset” ("Tilbagestil") for at ga tilbage
til de oprindelige fabriksindstillinger.

Er skeermen modstandsdygtig overfor
ridser?

Det anbefales generelt ikke at udsette
skaermens overflade for kraftige sted. Den
er beskyttet mod skarpe og stumpe ting.
Nar du handterer skeermen sa pas pa ikke
at trykke for kraftigt pa skeermens overflade.
Det kan pavirke garantibetingelserne.



SP7: Hvordan renggr jeg skeermens overflade?

Sv.:  Til normal rengering skal du blot anvende
en ren, bled klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug ikke
andre oplgsningsmidler sdsom ethylalkohol,

ethanol, acetone, hexan osv.

SP8:
Sv.:

Kan jeg ®ndre skarmens farveindstilling?

Ja, du kan andre farveindstillingen via OSD

pa felgende made:

* Tryk pa "OK" for at vise OSD (On Screen
Display)-menuen

* Tryk pa "Ned-pil” for at veelge indstillingen
"Color" (Farve), og tryk derefter pa "OK"
for at angive farveindstillingen. Der er tre
indstillinger, som vist nedenfor.

1. ColorTemperature (Farvetemperatur) -
De 2 indstillinger er 6500K og 9300K.
sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks. digitale
kameraer, skeerme printere, skannere
osv.)
. Brugerdefiner - brugeren kan valge sin
foretrukne farveindstilling ved at indstille
den rede, granne og bla farve.

2.

© Bemark

Et mal for farven pa lys, der udstrales fra et objekt,
mens det opvarmes. Dette mal udtrykkes pa en
absolut skala (kelvingrader). Lavere kelvingrader
sasom 2.004K er rgde, hgjere temperaturer sasom
9.300K er bla. Neutral temperatur; 6.504K, er hvid.

SP9: Kan jeg forbinde min skarm til enhver pc,
arbejdsstation eller Mac?

Sv.:  Ja.Alle Philips skeerme er fuldt kompatible
med standard pc'er, Mac'er og
arbejdsstationer: En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skeermen til dit Mac-system.Vi anbefaler; at
du kontakter Philips salgsrepraesentant for

yderligere oplysninger.

SP10: Er Philips skeerme ”Plug & Play”?

Sv.. Ja skeermene er "Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX,

Linux.

SP11: Hvad er "billedkleebning” eller
”billedindbraending” eller "efterbillede”

eller ’spogelsesbillede” pa skarme?

Sv.. Uafbrudt visning af stille eller statiske billeder
over en leengere periode kan fordrsage,

at det ""breendes fast” pa skaermen, dvs. de
sakaldte “spagelsesbilleder” pa din skaerm.
"Fastbreending” og "'spegelsesbilleder”

er velkendte faenomener inden for
skeermpanel-teknologien. | de fleste tilfelde
forsvinder "indbrending” eller "efterbillede”
eller "spagelsesbillede” gradvist, efter at
stremmen er slaet fra.

Serg altid for at aktivere en pauseskaerm,
der beveager sig, nar skaermen efterlades
uden at blive anvendt.

Serg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
skaermen viser indhold, der ikke skifter.

) Advarsel

Alvorlig "indbreending’- eller "efterbillede’- eller
"spagelsesbillede”-symptomer forsvinder ikke og
kan ikke repareres. Ovennavnte skader er ikke
daekket af garantien.

SP12: Hvorfor viser skarmen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv..  Skarmen arbejder bedst med sin native
opl@sning pa 1366x768@60Hz.
Brug denne oplgsning for at opna det

bedste billede.
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